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Introduction to Document Templates 

The Documents feature in Textura Payment Management empowers General Contractors and 
Owners to efficiently create and manage lien waiver templates and publish both lien waiver and 
other key project documentation for projects managed on Textura. 

Only users with Documents permissions will have access to this feature from their Tools menu. 
An Enterprise or Local Administrator can assign the Editor, Publisher, and View Only 
Documents roles to any user in your organization. 

Watch the Documents video. 
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=639028
3819112 

High-Level Overview 

1) Access the Documents Library (see "Navigate to the Documents Page" on page 29): 
Navigate to the Documents page to view all available document templates and begin the 
creation process. 

2) Create a Document Template: Select New Template to open the Template Properties 
page. Name the document, select the document type (conditional or unconditional lien 
waiver), choose the organization type, and configure additional settings if needed. 

3) Edit the Document Template: Use the Document Editor to add and format text, insert 
tables, include images, and add variables such as project details, signatures, or dates. 
Advanced features include adding conditional logic and page breaks. 

4) Preview and Review: Generate a preview to verify document template appearance and 
content. When complete, submit the template for review. 

5) Publish the Document: Once reviewed and approved, users with the Publisher user 
permission publish the document template to make it available for use on projects managed 
within Textura. 

6) Deploy on Projects: Project Managers can select published document templates to use in 
new or ongoing projects on the Project Settings page. 

FAQs 

Who can create and edit documents in Textura? (see page 31) 

What is a legacy document? (see page 31) 

When previewing templates, why is my project drop-down list different than that of 
another Documents user at my organization? (see page 31) 

Why can I not see signatures on my previews? (see page 31) 

What types of documents can I create? (see page 31) 

Can I upload a document to the Editor? (see page 31) 

Can I create a document template for Lien Waiver Only Sub Tier organizations on my 
project? (see page 31) 

https://players.brightcove.net/2985902027001/default_default/index.html?videoId=6390283819112
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=6390283819112
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What is the difference between Effective Date and Draw Period To Date? (see page 32) 

Can I define a calculation in a table? (see page 32) 

Can I log directly into the Documents Editor? (see page 32) 

Other Resources 

 In-App Help: In the application, click the ? > Help for this Page in the top right corner of 
your page. The Help topics presented are context sensitive to the page you are on. 

 Documentation Library (https://docs.oracle.com/cd/E97085_01/10313806.htm) 

 Support (https://docs.oracle.com/cd/E97085_01/10313339.htm) 
 

Document Templates Best Practices 

Formatting Document Templates 

 To save yourself some time, copy and paste the text from a document you already have 
saved to your computer or accessed online. You will still need to adjust formatting and insert 
variables, but you will not need to manually type out everything if you approach your 
template creation in this way. 

 Before adding a variable, resize and format your document template's text if you need to 
make any adjustments.  

 Pressing Enter on your keyboard will add a double space to your document template. To 
instead add a single space, press Shift + Enter. 

 You can use tables to mimic a signature block in your document template. Insert a table and 
adjust the table properties, cell properties, and cell borders to specify text alignment and 
display. By default, cell borders are not visible, but choosing to include the bottom border 
can act like an underline. 

Keyboard Shortcuts 

You can use the following keyboard shortcuts to make editing simpler: 

 CTRL + A: Select all text in the document template. You can then use the Document 
Editor Ribbon to apply text styling and alignment to the entire document template. 

 CTRL + C: Select text and then use the keyboard shortcut to copy the text to your 
clipboard. 

 CTRL + X: Select text and then use the keyboard shortcut to cut the text from your 
document template. 

 CTRL + V: Paste the text you either cut or copied from your clipboard to your document 
template. 

 CTRL + Z: Undo your previous action. 

 CTRL + Y: Redo an action you previously undid. 
 

Creating a Document Template 

Create a document template to use on your organization projects on Textura.  

To create a document template: 

https://docs.oracle.com/cd/E97085_01/10313806.htm
https://docs.oracle.com/cd/E97085_01/10313339.htm
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1) Navigate to the Documents Page (see page 29). 

The Documents Library page displays. 

2) Click New Template. 

The Template Properties page displays. 

3) Enter a name and select a document type. 

Note: Currently, you can only create conditional and unconditional lien 
waivers. Lien waiver creation for Lien Waiver Only Sub-Tiers (LW Subs) 
is not supported. 

4) Select the Organization Type to determine if General Contractors or Subcontractors will use 
this document. 

5) Optional. Choose a Page Type. 

The application defaults to selecting the Letter (8.5 x 11) option, but you can choose to 
change the Page Type to A4 (8.3 x 11.7 in) or Legal (8.5 x 14 in). 

6) Optional. Use the drop-down menus to change the page margins of your document template. 

7) Click Update. 

The Document Editor opens. The editor in Documents offers a range of formatting options 
to offer you some control over text appearance, styling, and alignment.  

Text entered in the Document Editor defaults to 12pt Helvetica font. 

8) Begin entering text for your document template.  

Note: You can paste content from your clipboard into the Document 
Editor. All formatting except hard returns will be stripped from the 
source and must be re-applied in the Document Editor. 

9) (Optional) Adjust styling by adding a table. 

See Adding a Table to a Document Template. 

10) (Optional) Add a header and footer. 

See Adding a Header or Footer to a Document Template. 

11) Either highlight entered text or place your cursor where you would like to add a variable. 

12) From the Document Editor Ribbon, add a variable. 

 Variable Plugin: Add a plugin to pull information from a project, contract, or organization 
profile into the document template, as well as Signer, Notary and custom-defined variable 
data. 

Note: All document templates need a signature variable. 

 Conditional Tags: Add a pair of conditional begin and end tags that apply to the content 
entered between the tags. 

For example: Use a conditional plugin to display text only when users sign a final 
unconditional lien waiver. 

See Using Conditional Start and End Tags in Document Templates for more 
information on how to add Start and End Tags to add a conditional variable. 
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13) After finishing the document template, you can: 

 Cancel: Select Cancel to return to the Document Properties page. 

 Preview: Select Preview to see a preview of the document template. 

 Submit: Select Submit to begin the Publisher workflow. 

▪ The Document Editor closes. 

▪ The document template's name, status, type, and creation information displays in 
a new line in the table on the Document Library page. 

Watch the Working with a Document Template video. 
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=639039
5937112 

Watch the Using Variables in Document Editor video. 
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=639039
8431112 
 

Using Conditional Start and End Tags in Document Templates 

Editors can define conditional logic by adding Start and End Tags to conditionally expose 
content of the document based on specified criteria. 

For example: An unconditional lien waiver might need different language depending on if an 
organization submitted a progress or final invoice for the project. 

To use conditional Start and End Tags while creating a document template: 

1) In the Document Editor, place the cursor where you want to add the conditional logic. 

2) From the top of the Document Editor, click the Conditional Plugin icon. 

A Conditional Statement drawer opens on the left of the page. 

3) From the Condition drop-down list, select a condition to use in the document template. 

4) Click Insert Start Tag. 

5) In the body of the Document Editor after the Start Tag, enter the text that will display when 
the selected condition is met. 

6) From the Condition Statement drawer, click Insert End Tag. 

Watch the Setting up Conditional Logic in Document Editor video 
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=639039
9917112. 
 

Adding a Table to a Document Template 

Document templates created on Textura support tables. 

To add a table to a document template: 

1) Move your cursor to the area of the document template where you want to add a table. 

2) From the Document Editor Ribbon, select the Insert Table icon. 

A Table Widget displays. 

3) From the Table Widget, select the number of columns and rows for the table. 

https://players.brightcove.net/2985902027001/default_default/index.html?videoId=6390395937112
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=6390395937112
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=6390398431112
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=6390398431112
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=6390399917112
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=6390399917112
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The Document Editor supports initial table sizes as small as one row by one column and as 
large as 10 rows by 10 columns. After creating the table, you can use the Table Menu to add 
additional columns or lines. 

4) (Optional) Edit column options. 

Select a table cell and then select the Edit Column icon to open a list of table options related 
to columns. 

 Header Column Toggle: Determine if the selected column and all columns to the left of it 
should use styling reserved for table headers. 

 Insert Column Left: Add a column to the left of your selected column. 

 Insert Column Right: Add a column to the right of the selected column. 

 Delete Column: Remove the selected column from the table. After deleting a column, 
your cursor will move to and select the next column to the right. 

 Select Column: Highlight and select all table cells in a column. 

5) (Optional) Edit row options. 

Select a table cell and then select the Edit Row icon to open a list of table options related to 
rows. 

 Header Row Toggle: Determine if the selected row and all rows above it should use 
styling reserved for table headers. 

 Insert Row Above: Add a row above your selected row. 

 Insert Row Below: Add a row below your selected row. 

 Delete Row: Remove the selected row from the table. After deleting a row, your cursor 
will move to and select the next row under it. 

 Select Row: Highlight and select all table cells in a row. 

6) (Optional) Merge cells. 

Select one or more table cells you want to merge or split. 

 Merge cell up: Combine a table cell with the cell above it. 

 Merge cell down: Combine a table cell with the cell below it. 

 Merge cell left: Combine a table cell with the cell to the left of it. 

 Split cell vertically: Split a table cell in two. When splitting vertically, the new cell 
displays below the original. 

 Split cell horizontally: Split a table cell in two. When splitting horizontally, the original 
cell and the new cell display side-by-side. 

7) (Optional) Edit table properties.  

Customize the appearance of the entire table. 

 Border: Add a border to the table.  

Border options include: 

▪ Top: Add a border to the top of the table. 

▪ Right: Add a border to the right side of the table. 

▪ Bottom: Add a border to the bottom of the table.  

▪ Left: Add a border to the left side of the table. 
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Note: You can also use the Bottom Border option as a way to fully 
underline a table, including its padding. If you use the Underline font 
styling, the underline applies to only the variable or text. 

▪ All: Add a border to all sides of the table. 

 Background: Add a color to the background of the table. Select from 15 available colors 
or use the Color Picker to choose a custom color. 

 Alignment: Choose how to align text in the table. Text uses the Center Table option by 
default, but you can choose to align text to the left or the right. 

After updating table properties, you need to select Save in the Table Properties dialog box 
to apply your options to the table. 

8) (Optional) Edit cell properties. 

Edit the appearance of a selected table cell. 

 Background: Add a color to the background of a table cell. Select from 15 available 
colors or use the Color Picker to choose a custom color. 

 Padding: Choose the amount of spacing a table cell should use between text and the 
perimeter of the cell. 

 Table cell text alignment: Choose how to align the text in a table cell. 

9) (Optional) Add cell borders. 

Select one or more cells in your table and then select border options. 

Border options include: 

▪ Top: Add a border to the top of your selection. 

▪ Right: Add a border to the right side of your selection. 

▪ Bottom: Add a border to the bottom of your selection. 

▪ Left: Add a border to the left side of your selection. 

Note: You can also use the Bottom Border option as a way to fully 
underline a cell, including its padding. If you use the Underline font 
styling, the underline applies to only the variable or text. 

▪ All: Add a border to all sides of your selection. 

After you add a border, you need to select Save in the Cell borders dialog box to apply your 
options to the table. 

10) (Optional) Change cell border properties. 

Change the appearance of the border of a cell. Select one or more cells in your table and 
then select border options. 

 Style: Choose solid lines or no lines. 

 Color: Choose a color for visible border lines from a predefined list of options. 

 Width: Choose the width of a border line. You can choose a line weight of 1px to 5px. 

After updating cell border properties, you need to select Save in the Cell borders dialog box 
to apply your options to the table. 
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Deleting Table Elements from a Document Template 

To remove a table from a document template: 

1) In the Document Editor, select the icon in the upper left corner of the table to highlight the 
entire table element. 

2) Use the Delete or Backspace buttons on your keyboard to delete the table. 

Note: You will also use this method if you need to remove a row from a 
single-row table. To remove a row from a multiple-line table, you will use 
the Table Menu from the Document Editor Ribbon. 

 

Adding a Header or Footer to a Document Template 

To add a header or footer to the document template from the Document Editor: 

1) From the top of the Document Editor, select the Header tab to add a header or the Footer 
tab to add a footer. 

 From the Template layout drop-down, choose how many columns the header or footer 
should contain. Textura supports up to three columns.  

Each column will include Content Type options.  

 Text: Add text to display in the header or footer on each page of the document template. 

The default alignment of content within the column depends on how many columns you 
choose for your header or footer. 

▪ One Column: Text is center-aligned.  

▪ Two Columns: The first column's text uses a left-alignment and the second uses 
a right-alignment. 

▪ Three Columns: The first column uses a left-alignment, the second uses a 
center-alignment, and the third uses a right-alignment. 

 Page Number: Insert page numbers across all pages in the document template. 

 Image: Upload an image to display in the header or footer of every page of the document 
template. 

 Variable: Select a variable to include in the header or footer of each page.  

 N/A: Do not include any content in the header or footer. Use this option if you chose to 
include multiple columns and want a column to contain only blank space. 

Note: You can only choose one Content Type per header or footer 
column.  

2) (Optional) Add text to a column. 

a. Choose a Typeface.  

Typefaces include Helvetica, Times New Roman, and Courier New. Before you choose 
an option, the typeface defaults to Helvetica. 

b. Select a Font Size.  
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Headers and footers support font sizes from 8pts to 18pts. Before you choose an option, 
the font size defaults to 12pts. 

c. If applicable, apply bold or italicized styling. 

d. In the Content field, enter custom text to display in the header or footer of every page.  

3) (Optional) Add a Page Number. 

a. Choose a Display Option. 

b. Choose a Typeface.  

Typefaces include Helvetica, Times New Roman, and Courier New. Before you choose 
an option, the typeface defaults to Helvetica. 

c. Select a Font Size.  

Headers and footers support font sizes from 8pts to 18pts. Before you choose an option, 
the font size defaults to 12pts. 

d. If applicable, apply bold or italicized styling. 

4) (Optional) Add an image. 

Either drag an image from your computer into the page or use the File Explorer to navigate 
to the location of your image. 

5) (Optional) Include a Variable. 

a. From the Variable drop-down, choose a variable. Available variables include: Signing 
Date, Project Name, and Signing Organization Name. 

b. Choose a Typeface.  

Typefaces include Helvetica, Times New Roman, and Courier New. Before you choose 
an option, the typeface defaults to Helvetica. 

c. Select a Font Size.  

Headers and footers support font sizes from 8pts to 18pts. Before you choose an option, 
the font size defaults to 12pts. 

d. If applicable, apply bold or italicized styling. 

6) (Optional) Select N/A to create a blank header or footer column. 
 

Previewing a Document Template from the Document Library 

To generate a document template preview from the Document Library page: 

1) Navigate to the Documents Page (see page 29). 

2) Select a document template from the Document Library table. 

3) Click Preview. 

A Preview Template drawer opens on the right side of the page. 

4) In the Preview Template drawer, select a project, contract, and draw from the available 
drop-down lists. Textura will use information from these selections when generating the 
document template preview. You will only see projects available to you across your 
organization. 

5) Optional. Select a check box to configure the preview to include additional options: 

 Final: Generate a preview of how a final document may look when signed by an 
organization. 
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 Progress: Generate a preview of how a progress document may look when signed by an 
organization. 

 Notary: Generate a preview of how a document may look when you define conditional 
logic for notary actions. 

6) Click Create. 

7) From the Document Library, click View Previews.  

The Preview page displays. 

8) From the table on the Previews page, select the document template to preview. 

The document template preview opens in a drawer on the right side of the page. 
 

Previewing a Document Template from the Document Editor 

You can preview a document template while creating or editing a template in the Document 
Editor. 

To preview a document template: 

1) From the Document Editor, select Preview. 

A Preview Template drawer opens. 

2) From the Project drop-down, select a project to use for the preview. 

Only documents in which you have access will populate this list. 

3) Choose a contract to use for the preview. 

4) Select a draw. 

5) (Optional) Choose to base the generated document template off of a final lien waiver. 

6) (Optional) Choose to include variable fields in the document template. 

7) Select Create. 

 A Creating Preview message displays at the bottom of the page while the document 
preview generates. 

 When ready, the document preview immediately opens in a dialog box. 

 You can choose download or print the document template. 

8) Select Cancel to close the dialog box. 

Note: When you generate a document template preview from the 
Document Editor, the preview will not display on the Previews page. 
Only document template previews generated from the Document 
Library display on that page. 

 

Publishing a Document Template 

Users with the Publisher role can publish the documents an Editor created for use on projects 
within Textura. 

To publish a document: 

1) Navigate to the Documents Page (see page 29). 
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2) From the Document Library, select the desired document template that has been submitted 
for publishing and click Review. 

The document's properties display. 

3) If the selected properties look correct, click Continue. 

A Review drawer opens on the right side of the page. 

4) From the Review drawer, select a project, contract, and draw from the available drop-down 
lists. 

5) (Recommended) Review both a final and in progress version of the document. You can also 
choose view notarization elements that may be conditionally displayed.   

6) Click Review. 

A message displays, informing you Textura is generating a preview. The preview then opens 
in a dialog box. 

7) From the dialog box, click Publish. 

 The dialog box closes. 

 The document's status changes to Published in the Document Library table. 

 Project Managers can now select the published document from the Project Settings 
page for use on a project. 

Watch the Publishing Document Templates video. 
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=636267
4759112 
 

Additional Information 

This section includes additional information about the pages mentioned in this guide. View these 
topics for an overview of table or setting field names and definitions. 
 

https://players.brightcove.net/2985902027001/default_default/index.html?videoId=6362674759112
https://players.brightcove.net/2985902027001/default_default/index.html?videoId=6362674759112
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Working With the Documents Library Page 

 

1) Document Search: Find specific document templates available to your organization based 
on your unique search input. Searches include content from all columns of the table, not just 
the document template name. 

2) Filters: Select one or more of the predefined filters to the right of the search bar to quickly 
filter the table to only show specific document templates that fit your selected criteria. Some 
filters require you to further define constraints after selecting them. When available, choose 
additional options from the drop-down list in the search bar. 

3) View Previews button: Open a Previews page to view all recent document template 
previews you generated. 

4) Preview: Generate a preview of a selected document template. Choose options from the 
Template Preview drawer to preview how the document would look for a specific project, 
draw, or contract. You can also optionally choose to generate a preview of a final invoice or 
include notarization, if the document template supports these features. 

5) Properties: View information about a document template you selected from the Document 
Table. On the Properties page, the document template's supported properties are marked 
with a check mark. 

Note: The Properties page is read-only. You cannot make changes to 
the document template here. 

6) Review: Before a document template becomes available for selection on a project, it must 
be reviewed, approved, and published. Select any document template from the Document 
Table with an In Review status to activate the Review button. Click Review to open 
document template information in a drawer on the right side of the page. Only users with 
Documents Publisher permissions can review, approve, and publish documents. 

7) New Template: Create a new document template. 
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8) Edit: Update an existing document template's properties and formatting. 

9) Copy: Copy an existing document template's properties to create a new document template. 

10) View Projects: Select a document template from the table and then select View Projects to 
open a Projects drawer on the right side of the page. The Projects drawer lists the projects 
currently using the selected document template. Additional project details include Project 
Number and Status. You can export this information as a CSV file. 

11) My Org Documents | All Documents: Filter the table to display only document templates 
that are in Draft status or used by your projects, or view all available templates. 

12) Document Table: By default, the table lists all document templates available to your 
organization in order of creation with newer document templates appearing at the top of the 
list. There are six columns in total: 

 Document Name: The name of the document template. 

 Project Count: The number of active projects using the document template. 

 Status: The current status of a listed document template.  

▪ Draft: An Editor has begun to create a document template but has not yet 
submitted the template for publishing by pushing it forward to the reviewer.  

▪ Legacy: The document is a generic document available to all organizations. 

▪ In Review: The Editor has completed drafting the document template and sent it 
forward to the review stage. The Publisher needs to either approve or reject it. 
Once approved, the document template moves to the Published state. 

▪ Published: The Publisher chose to publish the document template. The document 
template is now available to use on any project where you organization acts as the 
General Contractor. 

 Type: The way a document is classified on Textura. Document types include lien waiver 
(CLW), unconditional lien waiver (LW), invoice, and sworn statement. 

 Created On: The date the document template became available for use in Textura. All 
legacy documents have the same date. Newer document templates created by your 
Textura representative have different dates. 

 Created By: The name of the individual who created the document template. Generic 
documents available to all organizations list Textura-Legacy as the creator. Documents 
created by your Textura Representative list Textura Administrator as the creator. 

 ID: A number used to identify the document template in Textura. The template ID is 
based on order of creation and is useful for Support if you need to contact Textura for 
help. 
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Working with the Documents Editor 

 

1) Cancel: Cancel document template editing and return to the Document Library page. 

2) Save: Save your most recent changes to the document template. Consider frequently saving 
your work to prevent accidental loss of content if you navigate away from the page or 
experience a connection issue. 

3) Preview: Generate a preview of the document template. When you preview a document 
template, you will pick a project, contract, and draw to use as context for the preview so you 
can visualize how the document will look when presented to a Signer. 

4) Submit: Save and submit the document template for publishing. The document template's 
status changes to In Review on the Document Library page. 

5) Formatting Tabs: Select a tab to edit different sections of the document template. 

 Body: Access the workspace to add text and variables to your document template. This 
is where you will add the main content of your template. 

 Header: Add a header to the pages of your document template. Headers support up to 
three columns. 

See Adding a Header or Footer to a Document Template for more information. 

 Footer: Add a footer to the pages of your document template. Footers support up to 
three columns. 

See Adding a Header or Footer to a Document Template for more information. 

6) Document Editor Ribbon: Change the format of text in the Document Editor or add a 
plugin.  

From left to right, available formatting options include: 

 Font Family: Select a font for the document template. Available options include 
Helvetica, Times New Roman, and Courier New. 
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 Font Size: Control the size of the font in the document template. The Default option 
applies size 12 to your font. You can select a minimum size of 1px and a maximum size 
of 18px. 

 Font Color: Change the color of the font in your document template. Either choose a 
predefined color or use the color picker tool to enter a hex code or select a color from a 
color map. 

 Highlighter: Highlight a section of text in the document template. Either choose a 
predefined color or use the color picker tool to enter a hex code or select a color from a 
color map. 

 Bold: Apply bold or strong styling to text. 

 Italic: Apply italic styling to the text. 

 Underline: Underline text in the document template. 

 Text Alignment: Choose how to align text in the document template. Alignment defaults 
to left-aligned, but you can choose to align the text right, center, or justified. 

 Bulleted List: Add a bulleted list to the document template. You can also create 
sub-bulleted lists by increasing the indentation of a bullet. 

 Numbered List: Add a numbered list to the document template. You can also create 
sub-numerical lists by increasing the indentation of a numbered list. The first level of a 
sub-numerical list will adopt a lower-alpha formatting. A sub-numerical list under a 
lower-alpha formatted list will use lower-roman formatting. 

 Increase Indent: Increase the indentation of text on the left side of the document 
template. 

 Decrease Indent: Decrease the indentation of text on the left side of the document 
template. 

 Insert Table: Insert a table into the document template. After adding a table, you can use 
the Table Menu to add or remove rows and columns, change background colors, and 
select border settings. 

See Adding a Table to a Document Template for more information about how to add 
and edit tables in the Documents Editor. 

 Page Break: Add a page break to your document template. A page break will move you 
to a new page in the document template 

 Undo: Undo the most recent action you took in the Document Editor. 

 Redo: Only available after you undo an action. Reverse the most recent text or formatting 
you chose to undo. 

 Remove Format: Remove the formatting you applied to text in the Document Editor. 

 Plugins: The text ribbon includes variable options for the document template. Refer to 
numbers 6 and 7 for more details. 

 Insert Image: Add an image to the document template. Textura supports both JPEG and 
PNG file types. After adding an image, you can move and resize it within the template. 
The image will display in both the document template and any previews of the template 
that you generate. 

7) Variable Plugin: Select the icon to open a drawer on the left side of the page. From the 
drawer, you can select a plugin to pull data from a project, contract, or draw into the 
document template.   
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For example: Select the Project Name standard variable to insert the Textura project name 
into the document template at the time of signing, or select the Signer Signature Signer 
variable to add a placeholder for the electronic signature of the Signer of the document. 

8) Conditional Plugin: Select the icon to open a drawer on the left side of the page. From the 
drawer, you can use tools to insert Start and End Tags to define conditional logic Textura 
will apply to the content of the document. 

For example: In the case of a final invoice, specify an "If Final" Start Tag and End Tag to 
display text that is specific to a Full and Final Lien Waiver. When a user signs a full and final 
lien waiver, the content entered between the Start Tag and End Tag displays in their 
document. This content will not display on a progress lien waiver. 

See Using Conditional Start and End Tags in Document Templates for how to create 
and use a conditional plugin. 

9) Document Template: Use the Document Template as your workspace for text and 
formatting. 

10) Variable Token: Signifies the addition of a variable to the document template. Variable 
tokens help you visualize the placement of key information in your document template. 

 

Standard Variable Overview 

Variable Description Type 

Amount yet to be disbursed Sum of net invoices received that 
have not been disbursed; Contract 
Status total pending 

numeric 

Balance to finish Contract sum to date less total 
earned and retainage; G702 line 9 

numeric 

Billed amount to date Total completed and stored to date; 
G702 line 4 

numeric 

Billed this period Sum of work completed this period 
and material presently stored, as 
entered in G703 

numeric 

Bonding institution Bonding institution specified in 
project settings 

text 

Contract date Contract date of the signing 
organization 

date 

Contract description Contract description text 

Contract number Contract number of the signing 
organization 

text 

Contract sum to date Sum of original contract amount and 
net change by change orders; G702 
line 3 

numeric 
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Contractor project manager 
first name 

First name of the contractor project 
manager, as specified in project 
settings 

text 

Contractor project manager 
last name 

Last name of the contractor project 
manager, as specified in project 
settings 

text 

Contractor project manager 
phone 

Phone number of the contractor 
project manager, as specified in 
project settings 

text 

Count of applications 
submitted 

Number of draws in which the 
organization has submitted an 
invoice 

numeric 

Current payment due Payment this period; G702 line 8 numeric 

Current payment, previous 
draw 

Sum total of current payment due for 
all invoices prior to current period; 
G702 line 7 

numeric 

Default retention percent Default retention percent on the 
contract, a defined in contract 
settings 

numeric 

Disbursed amount Sum total amount disbursed on the 
contract, where status is disbursed 
or paid 

numeric 

Draw due date Draw due date entered on the 
initiate draw page 

date 

Draw name Draw name text 

Draw/Application number Draw number in TPM; Application 
number on G702 

numeric 

Effective date Defaults to draw period to date 
unless a different date is allowed at 
time of signing. 

date 

Funding organization 
address line 1 

Address line 1 of funding 
organization for the project 

text 

Funding organization 
address line 2 

Address line 2 of funding 
organization for the project 

text 

Funding organization city City of funding organization for the 
project 

text 

Funding organization 
county 

County of funding organization for 
the project 

text 
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Funding organization name Name of organization specified as 
the funds disburser on the project, 
which may or may not be the 
primary GC organization 

text 

Funding organization phone 
number 

Phone number of funding 
organization for the project 

phone 

Funding organization state State of funding organization for the 
project 

text 

Funding organization state, 
abbreviated 

State abbreviation of funding 
organization for the project 

text 

Funding organization tax ID Funding organization tax id text 

Funding organization zip 
code 

Zip code of funding organization for 
the project 

text 

General contractor address 
line 1 

Address line 1 of primary GC 
organization 

text 

General contractor address 
line 2 

Address line 2 of primary GC 
organization 

text 

General contractor city City of primary GC organization text 

General contractor county General contractor county text 

General contractor name Name of primary GC organization, 
regardless of funding organization 
for the project 

text 

General contractor phone 
number 

Phone number of primary GC 
organization 

phone 

General contractor project 
number 

Project number as entered by the 
GC 

text 

General contractor state General contractor state/province (or 
other country defined subdivision) 

text 

General contractor state 
(abbreviated) 

General contractor abbreviated 
state/province (or other country 
defined subdivision) 

text 

General contractor tax ID General contractor tax id generic 

General contractor zip code Zip code of GC organization text 

Invoice number Invoice number as system 
generated or entered in billing 

text 
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details during invoice workflow 

Lender Lender listed on the project. text 

Materials this period Materials presently stored, as 
entered in invoice and displayed in 
G703 

numeric 

Net change by change 
orders 

Sum of all change orders; G702 line 
2 

numeric 

Net retention this period Net total of retention held and 
retention requested this period 

numeric 

Organization role Role of the organization of the 
person signing the document 

text 

Original contract amount Original contract sum when first 
draw was initiated; G702 line 1 

numeric 

Parent contract date Parent organization contract date date 

Parent contract description Parent organization contract 
description 

text 

Period from date Draw period from date date 

Period to date Draw period to date date 

Period to date of last 
disbursement 

Period to date of prior invoice date 

Previous certificates for 
payment 

Sum total of current payment due for 
all invoices prior to current period; 
G702 line 7 

numeric 

Previous draw number Draw number of the previous 
submission 

numeric 

Previous period to date Draw period to date of previous 
invoice submission 

date 

Project name Project name text 

Project number Project number as entered by the 
person signing the document 

text 

Project owner city Project owner's city text 
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Project owner county Project owner's county text 

Project owner name Owner name text 

Project owner organization 
type 

Project owner's organization type text 

Project owner phone 
number 

Project owner's phone number phone 

Project owner state Project owner's state text 

Project owner state 
(abbreviated) 

Project owner's state, abbreviated text 

Project owner street 
address 

Complete street address of project 
owner (includes address lines 1 and 
2) 

text 

Project owner ZIP code Project owner's ZIP code text 

Project site city Site information city text 

Project site county Project site county text 

Project site legal description Project settings, site information 
property legal description 

text 

Project site name Site information site name text 

Project site owner Site property owner text 

Project site state Project site state/province (or other 
country defined subdivision) 

text 

Project site state 
(abbreviated) 

Project site abbreviated 
state/province (or other country 
defined subdivision) 

text 

Project site street address Complete street address of project 
site 

text 

Project site ZIP code Site information ZIP code text 

Remit to address, city, 
state, & zip 

Project remit to address, city, state, 
& zip 

text 



Documents Management for General Contractors  

 

 

Remit to city & zip Project remit to city & zip code text 

Remit to name Project remit to name text 

Remit to street address Project remit to street address text 

Retention held this period Retention held this period regardless 
of retention requested 

numeric 

Retention previous period to 
date 

Sum of all retention held prior to this 
period regardless of amounts 
released 

numeric 

Retention requested this 
period 

Amount of retention requested this 
period 

numeric 

Total earned less retainage Total completed and stored to date 
less retainage, G702 line 6 

numeric 

Total payments Payment to date numeric 

Total retainage Net retention (held less requested) 
for the life of the project; G702 line 5 

numeric 

User defined text 1 User defined text 1, as defined in 
project settings 

text 

User defined text 2 User defined text 2, as defined in 
project settings 

text 

Work completed prior to this 
period 

Sum total of work completed from 
previous applications; G703 column 
D 

numeric 

 

Signer Variable Overview 

Variable Description Type 

Signer address line 1 Signer's address line 1 generic 

Signer address line 2 Signer's address line 2 generic 

Signer city City of person signing document generic 

Signer email address Signer's email address generic 

Signer fax Fax number of person signing document phone 

Signer name Name of person signing document generic 
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Signer name (initials) Initials of person signing document generic 

Signer organization 
name 

Organization of person signing document generic 

Signer organization type Organization type of person signing 
document 

generic 

Signer phone Phone number of person signing document phone 

Signer postal code Signer's postal code generic 

Signer signature Electronic signature of signer generic 

Signer state State of person signing document generic 

Signer state 
(abbreviated) 

Signer's state, abbreviated generic 

Signer title Title of person signing document generic 

Signing date Date signed date 

Signing organization 
address line 1 

Address line 1 of the signing organization generic 

Signing organization 
address line 2 

Address line 2 of the signing organization generic 

Signing organization city City of organization of person signing the 
document 

generic 

Signing organization 
country 

Country of the organization of person 
signing the document 

generic 

Signing organization 
county 

County of the organization of person signing 
document 

generic 

Signing organization 
phone 

Primary phone number of the organization of 
person signing the document 

phone 

Signing organization 
postal code 

Postal code of the organization of person 
signing the document 

generic 

Signing organization 
state 

State of the organization of person signing 
document 

generic 

Signing organization 
state (abbreviated) 

State abbreviation of the organization of the 
person signing the document 

generic 

Signing organization tax 
ID 

Signing organization's tax ID generic 

Signing organization 
vendor # 

Vendor number of signing organization generic 
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Notary Variable Overview 

Variable Description Type 

DAN (Colorado clients) Document authentication number generic 

Notary certificate number Notary certificate number generic 

Notary county Notary county generic 

Notary date Notary date date 

Notary expiration date Notary expiration date date 

Notary municipality Notary municipality generic 

Notary name Notary name generic 

Notary signature Notary signature generic 

Notary state Notary state generic 

State notary seal Reserved space for official image placement 
upon notarization 

generic 

 
 

Custom Variable Overview 

Variable Description Type 

+ (Add New Document 
Variable) 

If the data dictionary does not include a 
variable you require for your document, you 
can add and define a custom variable. Click + 
(add) to manually create a new variable. 
Variable types include Text, Amount, and 
Checkbox. 

Text: Use custom text. 

Amount: Used for currency values. Amount values will include commas and displays 

numbers up to the second decimal point. 

Checkbox: Used for options. When a document uses a Checkbox variable, the 

signing user will see a check box they can select when signing the document. 

Text 

Amount 

Allow subcontractors to add 
contractor affidavit option 
text 

Will display if project setting is enabled; triggers 
alert on Manage Lien Waivers screen 

Text 

Disputed claims amount Triggers alert on Manage Lien Waivers screen amount 

Disputed claims detail Triggers alert on Manage Lien Waivers screen text 
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Optional text Will display if project setting is enabled, 
specifically 'Subcontractors may add lien waiver 
optional text'; triggers alert on Manage Lien 
Waivers screen 

text 

 

 

 

 

 

 

 





 

 

Navigation Topics 

Navigate to the Documents Page 

From the Tools menu at the top of any page, select Documents. The Documents page will 
open in a new tab. 

Note: Only users with Documents permissions will see this option in 
their Tools menu.  

 





 

 

Frequently Asked Questions 

Who can create and edit documents in Textura? 

Users with appropriate permissions, such as Editors, can create and edit documents. Publication 
requires a Publisher role. 

Enterprise and Local Administrators can assign the Editor or Publisher role to themselves or 
other users in their organization from the Edit User page. 
 

What is a legacy document? 

Legacy documents are those which were developed without using the Documents tool. 
 

When previewing templates, why is my project drop-down list different than that of 
another Documents user at my organization? 

The only projects users can preview are the same projects they have permission to access in 
Textura Payment Management. Permissions in Textura are unique to each individual 
organization user. Access to projects in Documents is determined by which permissions you 
were assigned on the User Roles and Edit User pages. 
 

Why can I not see signatures on my previews? 

Documents will pull document samples for previewing, but they are not physically signed 
documents. The preview will highlight the area on the template in yellow to represent where the 
signature would appear when someone signs the document. 
 

What types of documents can I create? 

At this time, the self-service tool supports the creation of Conditional and Unconditional Lien 
Waiver documents only. 
 

Can I upload a document to the Editor? 

No, you cannot upload a document to the Editor.  
 

Can I create a document template for Lien Waiver Only Sub Tier organizations on my 
project? 

The ability to create/edit a document template for Lien Waiver Only Sub-Tier (LW Sub) 
organizations is not supported as of the initial deployment of the Documents Editor feature but is 
currently in development. 
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What is the difference between Effective Date and Draw Period To Date? 

The Draw Period To Date is the default date the General Contractor enters when initiating a 
draw. If a project uses the Allow subcontractor to edit lien waiver effective date project 
setting, the Subcontractor Signer can enter an alternative date when signing their lien waiver 
document. When applicable, the effective date displayed on the signed document will differ from 
that of the Draw Period To Date. 

See Lien Waiver Settings 
https://docs.oracle.com/cd/E97085_01/TPMhelp/en/North_America/10309559.htm for more 
information on project settings related to lien waiver documentation. 
 

Can I define a calculation in a table? 

It is not currently possible to configure a calculation in a lien waiver document template. 
 

Can I log directly into the Documents Editor? 

You must first log in to Textura to use the Documents Editor and then navigate to the 
Document Library from the Tools menu. 

 

https://docs.oracle.com/cd/E97085_01/TPMhelp/en/North_America/10309559.htm
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